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W IS 2R 5 ) ARMO i A SUREE™ i AEAE B A5 1% 5 AR SRR I
ARG, REI KRB

— A S RN U, 41 EM9260

B IZ RS RN SR EC S (1) DT A DAt e AR

— gkt RS

— R LUK I R 2k

— A HIR AR

— IR R TR

Microsoft /2w [¥] Windows CE core %) 1E I 4% AUbR I

SRR AP X X HER R A SR SR AR 3R DBt 5 [ T
I VP Ak AR L 22 2BEAT AN I R 93, DL, IR AN SRR 52— AN O — FEX i AE 55 1%
IR AR SRATRC B HIT R PR, B — B BEBRTT R R S

WA EAE GBI AN LI R BRI FEAE 34T 3D RIT A, 5 Z AR — L 2

2%
([ ]

HE#— & HAT+5V r R H (10380 AR rR R BT OC B S (+5V£5%), ¥

AR AL I IR F YRR I A B B BRI +5V Sl b R AR D

T & @ T GPRS/CDMA N ITFKR, 1T GPRS/CDMA S B 5 (1)
[ ) g T Ik 2A\, R IR BT DG HAYR IS 6 S D) 32 A 10W A E 11

e — A LUK M B2 R 2 /b —A RS232 Hi L) PC HLIE N I & 1ML, % PC #L

2% Windows XP 4k & 4;

R 2444 — AN RE LR AN SUBTHUBSEHORI T R AL N 1 LUK 4 2%

JUEAZ T 1, AEh T IRIF R IERE , 0% - UE % — PIC AR HL (5, LCD ik,

H i EM9260/EM9360 1 |1 2/ 34 =i F 1) LCD #it: (1) 128X 64, KS0108

PEil#s; (2) 320X240, SED1335 #iil#%: (3) 240X128, T6963C #iil#s.

S AL EM9260/EMO360 1% ) 41 1 LA S 1] 2 W] by 75 B2 ) LCD Asde o o

IRAATTE LCD N, R SE G K (a7 B 2451 LCD RIAT, IS5 3 H A%y

ZAT.

— FURT LI A7 1) U A

www.emtronix.com 4 028-86180660




JEA(F R A BB A AR EM9260/EM9360 {3 A 4152 V1.00

WG 7 BT TR S AN FR K B T BLE— 285 T A s EERC #5427 AT REIE
A LG TR, e

o G ERIERY M, W AD Bk, 10 ¥ RS

® GPRS/CDMA il iflbib (fu1: Siemens MC39i) LA K K2k %5 b4
® SD fffiF

® )R B H A

XL BB 57, B IS 2% 1% fh A U] BT A

1.2 JFRIFRRE SR 23

TEL EAFUER U CUS, 3 nT LAEAT R IR BG4 T

(LA #LL EM9260 4], EM9360 1 i Ji X 5 EM9260 J5 =UAH[HD

PRUERCE (920 ARMO ik N UBEER FICAT A7 R Flash 74, JFE T IERKR
Windows CE #:E &%, &/ {EHF RN EAEH eVC FFR N T, JFiid LUK A 94
IRA BRI AT . A5

RN BB TT R PP ISR B A 4% T GPRS TRl gz T, RS485 Hiit,
RS232 #fi e S e pedi A LCD $511 SEPREERLFE 1. USB 2 FURI LUK W 2 4 1145, X 64
PR ) F P, AR AH OGSO bR VRGN DR JERAR SR AU (R B B2 1 IR Th BB FHVE o FF R DA IR
WA AT AP AB I R 7 (R Bade 4, RIS AETF RO B4R AL s L IETRT PCB E3& v] LA IF
R HEAT AN ] F B B I Sl — € 22, DU T 2 A0 AL A 8 o b = A sk P i 2
I, FFTEHMTIE G H O SR E A, DAL R R

RN ZBEHAT PR CAER: s AT OR R 1, TR VAL AR b A — ]
FEIBATRE R 2 2 AT VIR EE JP1, 25 %R 25 0T T, R 0K HE N IEH I8 /T
X EEN, REELURRER N2, WK 11, Z IR RN, B ki A
PAb T, B P A TR . R IE W AT IR EGS AT R 2T, % i
T i g 4R AN N SCAS S (dbginfo.txt / userinfo.txt) k% R Gk AT #F B AL E (A
PRIC B 7 oA 5 SCEAT A AD

HARERAE
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K 1-1 JP1, B D) kel

KPR BN UKL o[RS, R e AR SRR A LUK, ] 1-2, X
FETT 5 EHUA N SRR AL E 6 S N7 4 45 3 12

EAUKM

1-2 ¥ EM9260/EM9O360 ¥4l R ZeH A LLK M

r OHEE T LCD #ide, ml A PPA AR CN6 4 a2 A\ LCD ik, EM9260/EM9360 nJ
H B SCHF =R k2 ) 1 B (%A LCD fidbie: (1) 128X 64, KS0108 #iilds; (2)
320X 240, SED1335 #=fil#s; (3) 240X 128, T6963C = il#s . EM9260/EM9360 ff') SDK
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2 A EM9260/EM9360 1o 4T I AEAM I8 EE RS it e . W& 1-4 Fios .

K 1-4  FEABE(R S

IAE T AL R N A T HE, BKs BV B H 2B S b AR N OB e 2 i |
MRS Sk (CERIEST D, WK 1-5, BEi, AR BRI R LED $57R17 5%,

EAMES

K1-5 JFEARG LR
HARGNA LCD Bibk, b5, LCD BRAARR st i i .

Windows CE
FEBsh . ..
Erntronix & EM3ZE0 © 2007

1-6  SCFFHL( LCD 7R 1) ARMO BBk 5 5 5t i

FEIBATIRES, RGUAZIZAT 8 BBl RGABNE, Fibyallmif, Wi 1-7 fros, &
INARGR ST, CAlsfT i R R e AN RS
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¥ 4F H
EM926018: A i
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K 1-9  SCRFHLE LCD 2o i) ARMO B 2l ) St

2 TG

21 THEESAHH

HE0) ARMO T N AT IR TAERER: B RS AT, 7ERC BT 8 8
2T, P XX PR TR T R, DUE T AT TIT R

PR AR TTHLLLUS RS TR, st 1 T LUl eVC K L i T2
IRAVEIE QIR SEOUS TR F iR, SOHFE RS Thg . (ETFRIMEL, RAM AL TIX
FRAET

BATBE ARG TFHLLLG R4 A S F AT 5 AORRRE TP S8, HE N SR R
RYHIER TIXFRA T

HEA ARMO R SUBEER AR T iR om— R, JEI it JFRIRAR FRBkZas JP1 ok
SRR (JP 7E VAR 0 EL A G P 11D 0 JPA S, TR F IR JP1 Wi IT,

U AR T84T B

2.2 RSGEE U
Bt BBk 4 LLAN, F I8 75 EAE O AN FE 22 10 3C A dbginfo.txt 1 userinfo.txt k4
ARGEHIRIS1T I E DS E

2.2.1 dbginfo.txt
dbginfo.txt JT R AF 12 AL IR A HARHLAIIE K BN M 48 S50, 20 RGBT IT R
VAR, TUIDAZ0 = S A 1% SO e RO A7 T S K “NandFLASH” H kb, Hpy 7 &
%R OBURR S 88 € o0 S I AR B I 507, AN ZE SO
[LOCAL_MACHINE] SR IR,
DefaultGateway="192.168.201.8" //ERIA I 5C, HHs HI = i 45 194 465 (1) S B e B A
W 0.0.0.0, TSR B A (¥ c
IPAddress="192.168.201.205" IEFFHLIP Huhl, HA S AT HREE
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SubnetMask="255.255.255.0" 115 PG, AR ™ BITAE R 48 1R 52 B v B

[HOST_MACHINE] IFFR ENUE R

IPAddress="192.168.201.4" IFF R NP stttk A4k I =L SERr 1 B S
port="9300" I 15, R BRIME 9300, AFEE K
[SYSTEM] T4 At 2 [B] i 3

Store="50" FRGESCAF R P SCA5 o F 50 % A7 2 (] (7D

il dbginfo.txt FAEAN U B, ¥ U BH/E I RIKHY USB #2100 1, RidE JP1, 8K
Ja RS, R HS IR AN E] “NandFLASH” H 3, JFE U A 224 0 B
ECE . WP A S M 28 SO U, WA S LR sh Mg e 7 fi% U 4,
PRSI, R “NandFLASH” H UL E 28 WM SH0RE T2k, W
I PR 1% 4 JEORT (K 2 45018 24 dbginfo.txt, I FRRIE I U B0 A SO 6 3 R 4E 0
“NandFLASH” Hxtr, LUk RGERBOHT L E -
7T« Store H T/ FLAFfits 1], X515 P 1) (807 308 AR G SCA o H IR A4 1) 7 43 Lo
gefl o w ) BRI NorFLASH 350045 REe A - (B 50%), I/ AT LAl
M VCE B X B DO Y [ S K. i, SRR ] 70% 1)
fEhigas ], NV iZ F s : Store="30". %S4 M & 10-90, /T 10
B KT 90 M E R ALA CAERAE, SLi REERHATBOARCE .

2.2.2 userinfo.txt
userinfo.txt JT /A7 (R AEIZATIRE T HARHLI M2 SHORIFHL B 3217 IR IS 4L
AL RGN A Zhis AT N IR, 0 2502 56 4 9% S A i B 50 0T AE T IR B BB
“NandFLASH” Hzgrhe H A S alun ™ (RURER G IR 6038 4 S I i i 307, 9F
ANEFELEAFHD:
[LOCAL_MACHINE] IE RS L
DefaultGateway="192.168.201.8" //BRikI e, HHE /LIS REIT M AR E . 1%
W dk 5 dbginfo.txt H (KB AN E A [
IPAddress="192.168.201.205" MNEBSHLIP bk, ) BAT A . i IP Hubk
dbginfo.txt H (1) B E A& A A
SubnetMask="255.255.255.0" 7 FAHERY, AR I A i) S BRI AT MRS, %1
KD 5 dbginfo.txt WK E AN 2 A A
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[USER_EXE]

Name="serialtest.exe"

Parameters="COM1 9600"

[SYSTEM]

Store="50"

I PR R

IRGITHLA ST IR, BRIA Y serialtest.exe.
SRR IT R 56 LA K B O B R SO 44
PEAE X5 Z TRV U H AT BRIA SR 44, FRHLRD
Al 3histT D

RS TN BB IAT P SO E . skl
serialtest.exe [1Z4: WX COM1, WHFZN
9600. JF & 56 Bt LA JG AR LN 52 b . s P 1
SR RBATWIAEL, R A ZRU LR B X

TAFfids 2% 1) 1

ARG SCAF R P A5 15 FH 50% At 2 (8] (7D

1. PP “serialtest.exe” JELEHCT WInCE BROIAM R4 304k R, MUt

fo s AP B s 1S B T W R e B R JBE R 4E ) “NandFLASH” F

s, CH ) /a4 userinfo.txt (I {5 WV 2 4 e B A5 ) o7 5, B

“Name” @M ZW T s (AL LL userapp.exe HiD:

Name="\NandFLASH\userapp.exe"

2. Store Z X1 & AT J5 vk 1A userinfo.txt.

S I userinfo.txt, KTk EHL S 9G] ARMO fik A\ URiHe g 37345 4%, i eVC #1% X
PELL R SR TS R BN R 2 “NandFLASH” H s Gzl LK S 2 3
BRGS0, R RKIT JP1, AR5 BHUHZ), R userinfo.txt ik N 284k BR
WACE, I LSO B AT N R o W P F B8 O R, D) n] DL d F
BB HEM userinfo.txt, FFHUCGELL eVC XA ST LK HT I F R P S 61 2 R 4E 10
“NandFLASH” Hzgrr, LClbil REEECH BLE .

A R R P AR R S FIP A PR SESIAE, WETF S

S At

2. WRASUE R BE, WG 75 404 userinfo.txt.
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3 B ARAEN RN E

SR A F () ARMO RFBER (445 EM9000 A1 EM9260/EM9360), 375k 2 7l 1)
eVC HHATNHIFEF I K. eVC 2 SR AN RGN — D g 56 3% Ho ) % 23R
IF R TH, 5 PCF&MHNK VC IRFF T m B —5tk, W& CIC++RHAT R, [
It eVC #ifE >l EM9260/EM9I360 M HIFEFH KM 1L L . A4 eVC 42 eid i
PASCARTE RS R, 0 T A DG 22w 1) ARMO ik, eVC Ml EM9260 2 B #l &
—FEI, BUR L EM9260 44 eVC K SDK If14é. P g (1 A S A s fE ROt
ft) “eVC %" Fil “SOFTWARE” H#F.

3.1 eVC4 Hl eVCsp4 [f)z3E
1. fE4eE eVC Z R, I E Ja i B3 Microsoft NET Framework 1.1, 21T “eVC
Z%%¢/Dotnetfx” H % T Dotnetfx.exe, F|HILUIIE 3-1 Pros iVFR U SO 1R AE, W& [

B bk,

i Microsoft NET Framework 1.1 524§ ' =101 x|
_ Gt - a
Ml.cﬂ_msﬂm et i s
® NICROSOFT $XFFREERH P I I
y ﬁsﬁwmw ) =
P SR
II ~ FE W
E " FFERE @
|

& 3-1 [ Microsoft .NET Framework 1.1 ¥F 1] Hp
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2. .NET Framework 1.1 (&3 FEn &l 3-2 Fios.

ji Microsoft MET Framesrork 1.1 5236 o I”'Eﬂ
m A IEFE = A F
EFEZentEi s TEE
MI[,‘.fﬂSD-ft' JKET Framewerk 075
Net
— | []]]]
EfEEEEI
'I I ilasm. exe confiz, BHF: C:...: 353
Mg 13 B
E

3-2 Microsoft .NET Framework 1.1 %% 0 #¢

3. .NET Framework 1.1 Z¢5e e LUA ginl LAEEAT eVC4.0 1) %eé. 11T “eVC %%%
/eVC4” H3 R setup.exe, R4 HAIHAMIE R, LT EE next, ] ZE8k
IR, 2 HILWE 3-3 s Vel OIS HE, E+E | accept the agreement, [7] 55 %%
il

- Installation Wizard for eMbedded Visval C++ 4.0 EI

End User License Agreement and Limited Warranty

T Be sure to carefully read and understand all of the rights

L, and raztrictiens dezcribed in the EULA Tou will be azked Lo
review and either accept or not sccept the terms of the EULA
and limited warranty. Thiz product will mot zet wp on your
computer unless or until you sccept the terms of the EULA and
limited warranty. For wour fulure reference, you may print
the text of the EULA fron the eula txt file of thiz product.
Tou may alse receive & copy of thizs EULA by contacting the
Bicrozoft subzidiary serving your couniry, or wrile:
Hicrosoft Sales Inmfornation Center/One Micrezaft Way
IBadecnd WA QENEO-ATCG

5
EH‘D‘US!R LICERSE AGREEMENT FOE MICROSOFT SOFTWARE

ICROS0FT EMBEDDED VISUAL C++ 4.0

TUFETANT-READ CARRFINIY - Thi= End-llcer Licencze deresment :I
Prezz the FAGE DOWN key Lo zee more text ..

oy E accept the Elmﬂ

™ I don’t accept the sgressent Brint ]
ST ETEE Bt |

K 3-3 [ eVC4.0 w1
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4, BT HIFES S EHE, FTHF “eVC Zefilkey” UM%, SRR S 4
A, WK 34,

. Installation Wizard for eMbedded Yisual C++ 4.0 i ___N'J

Product Number and User ID

Flease snter your product’ s ID punber:

[fRTTH - [iD36T - [FRMSD - [6QHBP - [CFTHO
Fleaze snter your neme and your company’ = name

Touwr name:

Ivr.-'n troniz

Tour company = nams:

Im tronix

Cpack [ Beet > | Bt |

3-4 G LARIFIS

5. 7E2:3500 H kb 42 % Standard SDK for Windows CE .NET, 14 3-5.

I installation Wizard for eMbedded Visual C++ 4.0 |

Install eMbedded Visual C++ 4.0

Select the items you want installed from the list below by
clicking on the check bozas. An item can be desslacted by
clicking again om its check bex.

afibedded Vizual CHt 4.0 Products:

g eflbedded Visual 0+ 4.0

Gtandard SIE for Windoews CE . HE

TN ETEE Exit |

K 3-5 [ WIinCE KIFs#E SDK
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6. ARG 2% Windows CE Platform Manager, #ifiilz:%%, fn 3-6.

Installation Wizard for eMbedded Yisual C++ 4.0 =]

eMbedded Visual C++ 4.0 requires Microsoft Windows CE Platform Manager to function properly,
The Installation Wizard will now install Microsoft Windows CE Platform Manager,

Please make sure all applications are closed before you continue, Would vou like to continue?

(M)

3-6 Wik %% WIinCE Platform Manager

7. WInCE Platform Manager [#) %35t/ 3-7.

Microsoft Windows CE Platform Manager 4.00

| Pleaze wailt whils Windoves configures Microsoft Windows CE
Plattorm Manager 4.0

Time remaining: 14 seconds

TR

K 3-7 ‘%% WIinCE Platform Manager

8. w5 LG, RSN KT AN LT, %P Continue, Wik 3-8, H7E
B FOR M JUASXHEHE LB OK.

eMbedded Yisual C++ 4.0 Setup ] |

@ YWelcome to the ebMbedded Visual C++ 4.0 inztallation progranm.
L=

Setup cannot install system files or update shared files if the files are in use.
Before continuing, cloze any open applications.

Exit Setup

3-8 HIASKHIN LY
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9. & PRIV ITHEWE 3-9, AMEEMIBN, Bk GRENA

BB e Ae, US4 a8 H N R LA 52D

eMbedded Visual C++ 4.0 Setup B d

I the Optionz list, select the items you want installed; clear the items pou do not want inztalled,

& grayed box with a check indicates that anly part of the component will be installed. To zelect
all components in the Option list, click Select All.

D escription:

T — e P e e

|7 Comman Components 15345 KB C++ werzion 4.0 and all required
components

Change Optioh... |

Select Al |
— Installation Location Folder
C:\Program Files\Microsoft eMbedded C++ 4.0 Lhange Folder... |
Space required on C: 101389 KB
Space available on C: 13321 MB
Continue I Canicel
& 3-9 HihHE R
10. RETFUR %4 eVC4.0, ik 3-10.
eMbedded Yisual C++ 4.0 Setup Disk x|

Destination File:
C:h AEVENWCE400MBIMSAT _MP.EXE

K 3-10 eVC4.0 &kl f2

www.emtronix.com 15 028-86180660




JEA(F R A BB A AR EM9260/EM9360 {3 A 4152 V1.00

11, eVC4.0 %45 L n, BInl23%% eVCaspd. 21T “eVC % 3#5/eVCspd” H I R
setup.exe, 21 3-11 FrosPVFal PO 5HE, EFE | accept the terms in the License
Agreement, [F]& 2L

i{% eMbedded Yisual C+4 4.0 5P4 License Agreement x|

End-User License Agreement

Flease read the following license agreement carefully,

SUPPLEMENTAL END USER LICEN3E AGREEMENT FOR ﬂ
MICROSOFT SOFTWARE

Micro=zsoft Embedded Visual C++ 4.0 Zervice Pack

Felea=se 4

INPORTANT: EEALD CAREFULLY - The software components
accompanying this 3upplemental End Tser License
hgreement (TSupplemental EULLY), including any
"online™ or electronic documentation (collectively
"hdate Snfrware™ . ia subhdernt £o the terms and ;I

%' I accept the terms in the License Agreement.

" I do not accept the terms in the License Agreement,

< Back I Mext = I Cancel

K 3-11  [FlE sp4 Z &bl

12, R TIFUH%%E spd, Mk 3-12,
x4

Installing eMbedded Yisual C++ 4.0 SP4

Please wait while the Setup Wizard installs eMbedded Visual C++ 4.0 5P4. This
may take several minukes,

Skatus:

= Back | [0

3-12 %% sp4

www.emtronix.com 16 028-86180660
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13. sp4 LM LLG, 81T “SOFTWARE/SDK” H ¢ F AU (KBTI ELHeff) SDK %
REFLRE, ALl EM9260_SDK.msi J . & 1B E 3-13 it ifiiE, E£F% Accept, [
BB

i Em0260_0T1112 License Agreement . x|

End-User License Agreement

Be sure ko carefully read and understand the following end-user license agreement,
and then indicate whether vou accept or do not accept the terms of the agreement.,

This software will nok sek up on your compuker unless you accept the terms of the agreement.,
For wour Future reference, wou maw print the text of the agreement now using the PRIMT
button or obtain the text from the 'M3FT_SDE_EULS_ 1033 rtf File after installation. ¥ou may
also receive a copy af this agreement by conkacking the Microsaft subsidiary serving wour
country, or write: Microsoft Sales Information Center, One Microsoft Way, Redmond W
95052-6399,

END-USER LICENSE AGREEMENT FOR i’
MICROSOFT SOFTWARE

MICROSOFT CUSTOM SOFTWARE DEVELOPMENT KIT FOR WINDOWS CE 5.0
(Referred to as the "Microsoft Custom SDE")

Press the PAGE DO key ko see more bext,

Erint: | < Back I fext = I Cancel |

3-13  [A]& SDK Z23 Y
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14, HILWE 3-14 FXHGHER & +E Complete.

i Em0260_0T1112 Setup ) x|

Choose Setup Type
Choose the setup type that best suits vour needs

Custom

Allows users to choose which program features will be installed
and where they will be installed. Reconmended Far advanced
users,

Complete

Al program Features will be installed. {Requires most disk,
space)

< Back Mext = Cancel

314 bk
15, BRI 315, SEHELUR, HEEIHEI A b
x|

Installing Em9260_071112

Please wait while the Setup Wizard installs Em3260_071112, This may take several
minukes.

Skatus:  Copwing new files

= Back Mext =

Kl 3-15 SDK Ze3kid i
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3.2 HAITRARHILE
1. e BRI LG . $TJF “SOFTWARE/config” H 3%, K HLifi ) dbginfo.txt
SLRIBIA AR, FEARME T T A5 SOE 28 OCFIXA SRR B A8 55D,
DLEF M I KRB ] . ALK OGN 192.168.201.8; JF &K FHLH 1P Hitik 2y
192.168.201.4; TSl 255.255.255.0; K 7afil ARMO ik AZUBEER AL 1P kil
192.168.201.205.
I dbginfo.txt SCAF P 2N i 48 1 F
[LOCAL_MACHINE]
DefaultGateway="192.168.201.8"
IPAddress="192.168.201.205"
SubnetMask="255.255.255.0"
[HOST_MACHINE]
IPAddress="192.168.201.4"
port="9300"
[SYSTEM]

Store="50"

2. BESERUR RAFIX A SRR IS U B BT, SRJ5H U S PR 2514017 USB 2
Mk, EHEZ9EE) ARMY IR AR
e 1 U BN FAT SCHERSE, 7505561 ARMO fik N sURCERJGy7: I aff e UL Y 25
2. dbginfo.txt %22 B P U A N 21 95 6) ARMO i N A RHp . g5
WRBA BN, WG HTHREIIENL AR R RN W R A E AT, B G2 LA
JE FRGEE U BEA7 N 5] ARMO ik A\ USEH AT Ay

3. JFHLETEE] ARMO iR ABER BRI U SN2, T BUE WL U B AR IT
Wah. Befese (B U £ BRI E i NE) BUs, EIPRENLERS) eVC, RIFEHE

Tools->Configure Platform Manager..., 415 3-16.
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Tools Window Help

/‘1 Errar Loakup

A% Remate Call Profiler {WCESOD)

A% Remate File Viewer (WCESOD)

A% Remate Heap Walker (WCESOD)

A Remote Kernel Tracker (WCESOO)

/‘5 Remote Performance Monitar (WCESOO)
A% Remate Process Yiewer (WCESOO)

A Remote Registry Edikor (WCESIO)

A% Remate Spy-++ (WCESOD)

A Remote System Information (WwCESOO)
A% Remate Zoormin (WCESOO)

Select Remoke Tools *
Custorize, ..
Options. ..

ﬁ Macra...

Record Quick Macro
Play Quick Macro

Ckrl+Shift+R
CtrH-Shift+P

Canfigure Platform Manager. ..

3-16  PACE AL

4. FEFTFFRIX U AE ik B H bR 4% (dn: EM9260 Device), X5k £ 4141

Properties..., Wi 3-17.

Tindows CE Flatform Manager Configuration

Select a platform or dewice to

EENTAR e PO SRl

- EM9000 fdd Dewice
=8 EM9z60
S ENTZED Device

@ Windows CE Default Flatform

Delete

‘ropertles. .

i

About

www.emtronix.com
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5. 7t Device Properties X} 1% HE[] Transpor H1i%$¢ TCP/IP Transport for Windows

CE, 7t Startup 11i%+¢ Manual Server, 8} 5 1% 4% Transpor 171/ [f] Configure..., 4] 3-18.

Device Froperties ;

Dewice

IEH'EIEEEI Device

Select a transport and a startup server. Choosze Test to
verify that wou can establish a conmection to your target
device with the =zelected transport and startup server

Transpor:

ITCPHIP Transzport for Windows CE j Configure. . |
Startup

IMa.nual Server ;I Configure. ..

Cancel | Test |

K 3-18 EFEEENI RN

6./2)i% Fixed port, J1:7r 47141 /¢) Port number F#ii A\ 9300, 24 J5 £ Use fixed address
FILERETT R BN 1P ik, fnkd 3-19,

TCFfIF Transport Confignration ' EI

Configuration for desvice;
|EMEIEEEI Device

¥ Check connection status Interval [mzec]; IEEIEIEIEI

¥ Fixed port Fart number; |E|3|:||:|

Host [P
& Use fixed address: |1E|2.1 63.201.4 j

" Configure autormatically over zerial

(] Cancel |

3-19  TiCE P45 i LRI IT R TALRY 1P Mok
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7. ESERE OK, K4 = ANXHHE . 4R 5 & $¢ Tools->Remote File Viewer(WCE500),

W& 3-20 Frx.

Tools ‘Window Help

1 /7‘1 Error Lookup

™ Remote Call Profiler (WCESOD)
A Remote Eile Viewer (8WCESOD)

© A Remote Heap Walker (WCESOD)

A Remote Kernel Tracker (MWCESOD)

A Remate Performance Monitor (WCESOO)

/h,- Remate Process Yiewer (W CESOO)

A Remote Registry Editor (WCESOD)

A% Remote Spy-++ (WCESOD)

A Remote Swskem Information (WiCESOO)

A4 Remote Zoomin (WCESOD)

Select Remote Tools

Customize. ..
Options. ..
ﬁ Macra. ..
Record Quick Macro Ckrl+5Shift+R.
Play Quick Macro Ckrl+35hift+F

Zonfigure Platform Manager. ..

3-20 £+ Remote File Viewer

8. TEFH FIXTTRAE P IEFE Hbrbiss (40: EM9260 Device), Wik 3-21 fin.

www.emtronix.com

Select a Tindows CE Device

@@ Emgoon
=@ Emazen
R SEENTE) Device
@ Windows CE Default Platform

0K Cancel |

K& 3-21 EEHEA] ARMO ik AU Device

22
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9. 1k # OK HAHLT 15 B, REUTTR 5 9E6) ARMO ik A SUBEREETIER:, wilE 3-22.

Connecting to device

Device
PMQEEU Dewvice

Eztablizshing platform manager conmection to device

TCPFfIP Transport for Windows CE

3-22  JFRENH SR ARMO ik N ABEH g 3% 4

10, EHEL LA, Ko w00 ARMO RN USRI SO R, il 3-23. &
BE, BRAEIT AR5 2 2 E B 58 1o

E‘ Tindows CE Bemote File ¥iewer | _IDIEI

File ¥Yiew Commection Help

Ba| 2n| Sh| e8| 20| [5 B|x| i|s]

- 121 EWI2E0 Device |_JApplication Data
DH}' Documents

|_ | HandFlash
Dﬂetwork
DProgram Files
DRec}'cled
DTemp

|_71 USEDi sk
D'ﬂindows

Control Fanel. lnk

Ready ,_,ﬁl_ A
Kl 3-23 ), FHLE R H IS ARMS fik A sURBEH 4 1T SCAHE
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4 eVC MHREFIT R

HEALLFHER) ARMO N UBCHUIT T (KRR SR TF R IREE, R LLK RO IF R LR
78] ARMO R N SBHERE R DI LU, I st LU eVC T 1l B Sl BN RS
¥ 7T

eVC JFARFAEENIGE 1K) VC ARHAHAEL, 2y DU i _EARH WK VC B4 BER
KAAT I AR TT I ) o ARTT, AEH eVC JFAM VC B KIX 2 —7ET VC JFRKIFEF?
BT Tl PC HL: eVC JFAR N R e 2 2445 HARBLIm AR PC ML Lz ATl X —
R R VC B S I NI ik A xCR Ge i LRI T AR 1) o PR, AFH /4 eVC
IRE R B AR 07 10 LA R AR s AT R L Ia AT AT NI RE P (0 7525, AR5 Rl =AM
PRI R AR 7 SR A SR U AT 4 eVC IF R I HARHL T AE FH P R AT A s AT 72
Fe, %P Al E X = AR R EMO260/EMO360 g /7 X LR &AM Al ], A g
LCD Wzl #H. BURIM L KEHCF 10 H4E,

41 Qg eVC EFE
1. EM9260 1F 7 JA 8l LA 1Y S8 1w 0 40 1] 4-1

FoQUR L]
EMO260H: A FLEH
Emntronix & EM3ZE0 © 2007

K 4-1 9ef) ARMO i A\ UBEER TR R 3l LS A 755 i
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2. B3 eVC, it# File->New..., K& 4-2 fi/~.

File Edit Wew Insert Pro

D T

(= Open. .. Chrl+0
Zlose
Cpen Workspace, .,

Saye Workspace
Close Warkspace

H Save Chrl+5
Save f5..,

ﬁ Save ol

Fage Setip. ..
&S5 Print... Chrl+F

Recent Files »
Recent \Waorkspaces  »

Exit

Kl 4-2 1F eVC Hifrgt

3. 7 Projects T 1% £ WCE Application, J{{r4ii/1 Project name i N\ T4
% hello, E Location H1458 ¢ 1% T REMIAAGALE, 11 4-3 FioR.,

hew 21 x|
Files Projects |Workspaces |

[E]WCE aApplication Project name:
L1 WCE ATL COM AppWizard

|hello
|%] WCE Dynamic-Link Library
WCE MFC ActiveX ControlWizard .
Location:
EWCE MFC AppWizard (dIl) e
SIWCE MFC AppWizard [exe) [D:istudyihello ]

%|WCE Static Library

@ Create new workspace
¢ Add to current workspace
["| Dependency of:

I El

CPUs:

CWin32 [WCE ARMV4) N
MWin32 [WCE ARMVAIL

[CWin32 [WCE ARMVAT)

CWin32 (WCE MIPS16)

[OWin32 [WCE MIPSII)

CWin32 [WCE MIPSII_FP] =

0K | Cancel |

4-3 LR
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4, FEFRMAHEHE S %L+ A simple Windows CE application., 1% 4-4 . SR)5
I Finish, JREFE OK A3t 1) TRE(S EHEHE, TFE hello BIg 7 5g b,

W/CE Application - Step 1 of 1 N el L

“hat kind of windows application would vou
like to create ?

" An empty project.

" A simple Windows CE application.

" A typical "Hello ¥World!* application.;

< Back MNext > Finish Cancel

Kl 4-4  EPE TR

5. eVC 3R, w7 AR VC —FE. 18] 4-5 72 hello Hf 3Cff.

J_ hello ~||EmM3000
e

= hello files
EI «S Source Files

. #] hello.cpp

....... Stdhfx cpp
I 23 Header Files
#-[_] Resource Files
- ReadMe.b<t

q [
*acl... |@Re...| ZFil...

K 4-5 TFE hello i3 fF
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6. MR ARG . A B TR A RREIS CA] DL a5 A
Build->Execute 5 # il Pftt i CtrI+F5 $iT %4, WK 4-6 Pin, JFiELkiksE OK
DARAA T Y BT AE, TR TF R S AT -

[y E ol

4-6  4wiFiz4T hello

4.2 HEEITENATREITRER
1. % Tools->Remote File Viewer(WCE500), %44 / LLJ5, #TJF “EM9260

Device/NandFLASH”, Wi& 4-7 fins.

BN Windows CE Remote File Viewer E”Elgl

File Y¥iew Comnection Help

2ol gn| B/ 2 [fEE | @[] x] 1|4

EM9Z60 Device |_JDocuments and Settings
(3 Fetwork dbginfo. txt
4123 FeandFlash stepl_led. exe
+ (1] USBDisk
{3 Recycled

{1 Application Data
1 My Tocuments
[ Program Files
3 Tenp

47 Windows

K 4-7 EM9260 NandFLASH H 3 [ e

2. fTJF “SOFTWARE/config” H3k, ¥4I userinfo.txt SR AHMERL, FHAR
P BT AE A 25 DL A 2 T IXASCF I LS8 —35).

LAZE BT R IREE Syl ASHB G4 192.168.201.8; 1MLk 255.255.255.0; X
G ARMO ik A SRR H 2y A IP ik 192.168.201.205 5 Him 4T 1 30 2
STEP1_LCD.exe;: 5%,

1] userinfo.txt SCA- IR P 2% 8 4 i Gl F

[LOCAL_MACHINE]
DefaultGateway="192.168.201.8"
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IPAddress="192.168.201.205"
SubnetMask="255.255.255.0"
[USER_EXE]
Name="\NandFLASH\STEP1_LCD.exe"
Parameters=""
[SYSTEM]
Store="50"
1: userinfo.txt AN 7 75 5 R G8 TAE Tia AT AU I A G 0F AL 2 e @i,
DR ARG TAE TR, MIDERERA S [N, o i M S B R 2 1
UL~ Y dbginfo.txt HEYIEANAE, SR R SRS bR TAEPIE A

3. siififr BJ7 THE P s A m L&k (i n] LUl 5 .42 1) File->Export File 11T
22D, WE 4-8 Pron, (EHH O IEHE P IERENIA gL 1) userinfotxt, L, I
SHIF eI (ki STEP1_LCD.exe B4R HIE] T “NandFLASH” HkHh, Fik
Toiwe FHRE . W P 145 2 N R P I ANAE “NandFLASH” Hsgrhr, U2 fg H [R)
FER LS E D

Efa|x] o]

4-8 F# userinfo.txt

4. WITIF AR L1 JP1, ER ARS8, JTHLLUG &R 48 H 34T #e) STEP1_LCD.exe,
BN E i 4-9 Pron. WA AT B AT R e o

4-9 IZfTF)¥ )G LCD WoR Hifi
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4.3 STEP1

STEP1_LCD &M FMllik LCD &/nFi)y. 24 /7 iE#i %% T EM9260/EM9360 [1) SDK
Jii» A5 LCD_APILIB 75N I JZE SO B 222 2T A ENLEIAIN. H o R o #:4F LCD B+
AN LR HUE UAE LCD_APLH ™, 5% S 251250 T i D s B g e Rk A
PR B S0 (5 /2 LCD_APLLIB v, DRUEAERE 7 2] LCD Yo, %A PRJ X
b Link % LIB . &EWR:

oject Settings

Settings For: General | Debug | CiC++ Link | Resources | Mg EE
Win3d2 [WCE ARMYA4I) Debu v
IWind2 WCE ARMVAI Debus 7| ooy (YO =] noset |

Output file name:
IARMVdIDhg.-'stem_lcd.exe

Object/library modules:

Icummcirl.lih coredll.lib lcd_api.lib

¥ Generate debug info [ Ignore all default libraries

[” Generate mapfile

Project Options:

commectrl.lib coredil.lib lcd_api.lib fnologo ~
{base'0x00010000" fstack:0x10000,0x1000 =
fentry'"WinMainCRTStartup” fincremental:yes

0K | Cancel

STEP1_LCD - 4Rt F -

// initialize LCD

type = LCD_Init(LCD_AUTO );
/itype = LCD_Init( LCD_12864 );
/type = LCD_Init( LCD_240128 );
/itype = LCD_Init( LCD_320240 );

if( type<0) return -1;

MaxX = LCD_GetMaxX( );

MaxY = LCD_GetMaxY( );

www.emtronix.com 29 028-86180660




JAME BEARA R A E] S A0S EM9260/EM9360 11 H 241 V1.00

RowNum = MaxY/16;
RowsStart = ( RowNum - 4 )/2;

Rowldx = RowStart;

/I show chinese char at center position
strepy( BufStr, "™* XmiEg " );

x = (MaxX-strlen(BufStr)*8)/2;

y = Rowldx*16;;

LCD_WriteString( x, y, BufStr, 1);

Rowldx++;

strepy( BufStr, "k A M £ HEER" );
x = (MaxX-strlen(BufStr)*8)/2;

y = Rowldx*16;

LCD_WriteString( x, y, BufStr, 0 );

Rowldx++;

/I draw lines
LCD_DrawlLine( 0, Rowldx*16, MaxX-1, Rowldx*16, 1 );
Rowldx++;

LCD_DrawLine( 0, Rowldx*16, MaxX-1, Rowldx*16, 1 );

/l draw curve
for( x=0; x<MaxX-1; x++ )
{
y = (Rowldx*16-8) - 8.0*sin( 2.0*M_PI*x/24.0 );

LCD_PutPixel( x,y, 1);

for( x=0; x<MaxX-1; x++)
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y = (Rowldx*16-8) - 8.0*sin( 2.0*M_PI*x/24.0 );

LCD_PutPixel( x, y, 0 );

LCD_FillBar( 0, Rowldx*16, MaxX-1, (Rowldx+1)*16, 1 );

LCD_FiliBar( 0, Rowldx*16, MaxX-1, (Rowldx+1)*16, 0 );

Sleep( 1000 );
LCD_Clearup( );

LCD_Delnit( );

44 STEP2

(UL EM9260 4y fil) Fiify STEP2_Serialtest “:EETfg Jy it FIIR, 4FEF IR E i 1
BRI, o S R ) Eis SOk L2 RN ISR EM9260 #2411 GPIO SEIL T
—> 3X3 HF AT, DU TR OB SR e oRaR Y, a4k b LCD, my DU
R R, AR OB DR R B B (R

%F EM9260 1) ISA 125 LL K GPIO iy F ok 535 5 XAE EM9260_ISA_DIO.h 1, %
JUR BT T IR A SRR E o HARK R B AL &/ EM9260_ISA_DIO.LIB i,
MISTEP1 —FEif, STEP2 sf b7 HI %] T LCD %o, Al STEP2 i {# il T EM9260 () GPIO
e, KbE PRI SOfFA 5 ] N4 RE LCD_APLLIB Al EM9260_ISA DIO.LIB, 41 K
Fs:
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Project Settings 2 %]

Settings For: General | Debug | CIC++ Link | Resources | MI EE
Win32 (WCE ARMVYAI) Debu i

[Wind2 (WCE ARMYAN Debug 71| ¢oroqory: (TN -] Fest |
ER=E step?_serial |

Output file name:
IARM‘MIDhg.fstep2_serial.exe

Objectflibrary modules:
Icummctrl.lih coredll.lib lcd_api.lib EM9260_I5A_DIO.LIB

¥ Generate debug info ™ Ignore all default libraries

[~ Generate mapfile

Project Options:

»

commctrl.lib coredll.lib lcd_api.lib ~
EMI9260_ISA_DIO.LIB /nologo fbase:"0x00010000" =
{stack:0x10000,0x1000 tentry:'WinMainCRTStartup"

0] 4 | Cancel |

STEP2 H: LR34 EM9260 (1) COM3 [, Jif LA{Eis AT FE 7 Ay 224 COM3 [
LR oy, Gl WA ENL PC R O3k SRS /E EM9260 i Lizdr
step2_serialtest 1£/7. 7t PC Hl_LiaqT “ & LHIAEI T 7 FE° 2# Windows ) “ 4% ¢ i 7
FEFF, 8 R T 7 REFPAEIT RO “IR TR ” B3R RIRERLS o Dl RS 4
9600 JAFA. 1 AMEILAL. 8 NEEAL, JoF B, Rl Wi EM9260 i1 T
fEIEH, EM9260 ¥ LCD F¥¢ B onFaliciiids A ik Hdis K B2, PC L it & 21 EM9260
BRI R i - EMO260 AEIa A I Ie FE Hhon] LA 4% 8, IRE 42 B 1) B A R\ 7 /E LCD
b R4z HE 4 [KINO - KOUTO] %i#%, STEP2_serialtest F Kl i

| <

4.5 STEP3

(LA EM9260 151> STEP3_tcptest T ZUIH T-LIKM LMK, 1227 Ll g
— AT TCP (RS #S, 0IWr TCP iR, WALERAT, W ab MR B B, n]
L)V S5 I s 7 150 B O R &, 0 T A R Bk LR R 4 2 7 it Sk T IRy
A1 STEP2 —Ff, fEI%FEFH AT LCD SoRUAR R A E, Mtk STEP3 )
PRJ [f1¥% B A STEP2 —#f.

STEP3 FJ7uATlANS, Hdr EM9260 ik iz Ty, Ra{: PC #Hl iz
tcptest.exe, toptest PP S EFFAOUH T “WHATH” HX N fEXHEE S, e “& )
BL70 7E “MRS5 4857 A2 H Pk EM9260 1 IP Hadilk (f1: 192.168.201.175), A5

www.emtronix.com 32 028-86180660




R BEARA A BB A AR EM9260/EM9360 {3 A 4152 V1.00

s “HEEHE7, TCP 4 —HAr, JERAG WS BRI BOBOS, WNTA 8 i kIE 5,
Pk 3% BN U, G SRV RHE T, AN FAF i, ATk i%, toptest
¥ 3% VSIS B ) A 4 LU PC HLIY R 40 TH) 1) EM9260, EM9260 Wil 5, ¥i% &4k
I ) B B EMO260 f St il A RAE N BHE S, BN “Time”, st RIEfE, AR
BEHO R 1% 4 5, RS2 EMO260 (¥ Sy i, Az A I 1 R [0 2R PC. 2R3
BAEP AR K, EMO260 WIS, 2o H AR M E A PC. [ STEP2
R, IS AT A R R A N g, R B R R s AE LCD L, i i A HLKINO
- KOUTO] %%, STEP3_tcptest FL/FKil .

L TCP Test lﬁ]
ERTRE [EP7 | BeHom [se 168 20 11s
Be@mo [roo == I i

#e | #ig |

FetBox Set

Time

123456

Time

2007-12-10 15:46:03
Z007-12-10 15:46:07
123456

Z007-12-10 15:46:15

AR SRR
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